
13. Georeferenciranje skenirane karte 

Pri unošenju prostornih podataka u GIS se često koriste postojeće papirne karte. Kako bi 
se podaci sa papirnih karata mogli u punoj meri koristiti u GIS-u, potrebno je izvršiti 
prevođenje ovih podataka u digitalnu formu. Popularni naziv za ovaj postupak je 
digitalizacija. U postupku digitalizacije je potrebno proći nekoliko koraka, kako bi se na 
kraju dobili podaci u željenom obliku. Digitalizacija topografskih podloga može da se 
izvrši korišćenjem posebnog hardverskog dodatka računaru: digitajzerske table ili 
koristeći skeniranu sliku topografske podloge. U okviru ovog praktikuma će biti opisan 
postupak digitalizacije topografske podloge sa skenirane karte. Kako bi se obezbedila 
dovoljna tačnost digitalizovanog sadržaja, poželjno je koristiti kvalitetni skener i skenirati 
kartu u rezoluciji 300 dpi (300 piksela po inču) ili većoj. 

Za georeferenciranje skenirane topografske podloge potrebno je poznavati koordinate 
određenog broja tačaka prikazanih na topografskoj podlozi. Minimalan broj poznatih 
tačaka zavisi od metode transformacije koja će se primeniti kod georeferenciranja. Za 
najjednostavniji model transformacije, neophodno je poznavati koordinate najmanje 
dve tačke. Pri izboru poznatih tačaka, na topografskim podlogama kao najpogodnije se 
mogu izabrati tačke temena koordinatne mreže, ukoliko ona postoji. Ukoliko 
koordinatna mreža nije prikazana na topografskoj podlozi, onda se mogu odabrati 
karakteristične tačke za koje je moguće utvrditi koordinate. 

Za QGIS postoji dodatak (plugin) Georeferencer pomoću koga se mogu georeferencirati 
skenirane topografske podloge. Georeferencer se može pozvati iz padajućeg menija 
Raster -> Georeferencer -> Georeferencer. 

Napomena: Ukoliko se ovaj dodatak ne nalazi u pomenutom meniju, treba proveriti da li 
je dodatak instalisan. Provera se vrši u padajućem meniju Plugins -> Manage and Install 
Plugins. Za ovu radnju je potrebna internet konekcija. Ukoliko dodatak nije instalisan, 
treba ga u ponuđenim dodacima označiti i instalisati. 

Postupak georeferenciranja počinje otvaranjem novog projekta. Za novi projekat se 
mora odabrati koordinatni sistem, isti koji je korišćen pri izradi karata. Za vežbu 
georeferenciranja jednog lista  topografske karte razmere 1:25000 treba odabrati 
projekciju MGI 1901 / Balkans zone 7. EPSG kod ove projekcije je 3909. Ovo je oznaka 
Gaus Krigerove projekcije, 7. zona, koja se u prethodnom periodu koristila za državni 
premer. 

Nakon definisanja koordinatnog sistema, pokreće se Georeferencer (Meni Raster, stavka 
Georeferencer). Ovim će se otvoriti prozor Georeferencera. Prvo je potrebno učitati 

skeniranu kartu funkcijom Open raster . U dijalogu koji se zatim otvara treba 
pronaći datoteku 378-2-3.tif u folderu D:\GIS Vezbe\. Nakon toga je potrebno odabrati 
koordinatni sistem odnosno projekciju karte koja će biti georeferencirana. Odabrati MGI 
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1901 / Balkans zone 7 (EPSG 3909). Nakon ovoga u prozoru Georeferencera treba da se 
prikaže odabrana skenirana karta. 

 

Slika 28 Prikaz skenirane topografske karte za georeferenciranje 
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Sledeći korak je dodavanje referentnih tačaka, na osnovu kojih će se izvršiti 
georeferenciranje. Za ovaj primer će biti korišćena četiri temena kvadratne mreže karte. 
Koordinate ovih tačaka su date na slici (Slika 28).  

Za dodavanje referentnih tačaka se koristi funkcija Add points .  

Nakon pokretanja funkcije Add points, potrebno je korišćenjem Zoom i Pan funkcija 
uvećati teme kvadratne mreže u gornjem levom uglu karte i što tačnije označiti ovu 
tačku. 

 

Slika 29. Označavanje preseka linija kvadratne mreže prilikom georeferenciranja 

Označavanjem tačke se otvara novi prozor gde se unose koordinate ove tačke (Slika 30). 
Nakon unetih vrednosti, ovaj prozor se zatvara pritiskom na dugme OK. 

 

Slika 30. Prozor za unos koordinata označenog temena kvadratne mreže 

Potrebno je označiti i uneti koordinate za sve četiri tačke. Nakon dodavanja tačaka, sledi 

izbor vrste transformacije kroz funkciju Transformation settings . Ovime se otvara 
novi prozor: 
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Slika 31 Podešavanje transformacije kod georeferenciranja 

Za vrstu transformacije odabrati Polynomial 1 (Afina transformacija). Takođe je potrebno 
odabrati putanju i ime za novu transformisanu sliku karte: Output raster: Ovde treba 
odabrati novo ime 378-2-3_g.tif. Za Target SRS treba odabrati MGI 1901 / Balkans zone 7 
(EPSG:3909). Ukoliko se želi da georeferencirana karta nakon ovog postupka bude već 
učitana u QGIS, treba označiti opciju Load in QGIS when done. Nakon toga se 
podešavanja potvrde pritiskom na OK. 

Postupak georeferenciranja se zatim završi funkcijom Start georeferencing . Ukoliko 
je sve korektno urađeno, pojaviće se prozor koji prikazuje fazu georeferenciranja. Kada 
se ovaj prozor zatvori, georeferenciranje je završeno i može se zatvoriti prozor 
Georeferencera. Pri zatvaranju će se pojaviti upit da li se žele snimiti referentne tačke. 
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Ovo može biti korisno ukoliko se eksperimentiše sa različitim vrstama transformacije. Za 
ovu vežbu se izbegne snimanje tačaka pritiskom na dugme Discard.  

Nakon georeferenciranja u radnom folderu će se pojaviti novi fajl 378-2-3_g.tif koji je 
tipa GeoTiff. Ovaj fajl se sada može učitati u GIS program bez novog georeferenciranja. 
Ukoliko se raspolaže georeferenciranom kartom koja nije u GeoTiff formatu (običan Tiff 
format), uz ovu datoteku u istom folderu mora da stoji i druga datoteka koja ima isto 
ima a nastavak tfw. Ovo je takozvani world fajl, odnosno datoteka koja sadrži podatke 
gde se skenirana karta nalazi u koordinatnom sistemu. Drugim rečima, GeoTiff 
predstavlja datoteku u kojoj su objedinjeni podaci iz obične tiff datoteke i podaci iz tfw 
datoteke. 

 Snimiti ekran sa georeferenciranom kartom. 
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14. Digitalizacija tačaka sa georeferencirane karte 

Georeferencirana karta iz prethodne vežbe će biti iskorišćena za digitalizaciju, odnosno 
izradu novih slojeva, precrtavanjem potrebnih sadržaja sa georeferencirane karte. 

Prvi korak je otvaranje novog projekta: u padajućem meniju stavka Project -> New. 

U novi projekat se zatim učitava georeferencirana karta izborom odgovarajućeg 
dugmeta u paleti za dodavanje slojeva:  

 

Slika 32. Dugme za dodavanje novog rasterskog sloja 

Ovim se otvara standardni windows-ov dialog Open gde se potraži i označi ime fajla koji 
sadrži georeferenciranu kartu 378-2-3_g.tif . Nakon potvrde se na grafičkom prikazu 
prikazuje karta. Pomeranjem miša po karti i praćenjem koordinata u statusnoj liniji, 
koordinate treba da odgovaraju koordinatama prikazanih tačaka u Gaus Krigerovoj 
projekciji. Nakon ovog koraka se može pristupiti formiranju novog sloja u koje će se 
smeštati digitalizovane tačke. Zadatak će biti digitalizovati karakterističnih tačaka terena 
u visinskom smislu – kota, koje su prikazane na georeferenciranoj topografskoj karti. U 
postupku digitalizacije će se u atributnu tabelu upisivati i nadmorska visina 
digitalizovane tačke. 

Novi sloj se može formirati pritiskom na dugme  na paleti za rad sa slojevima. 
Ovim se otvara prozor gde se definišu potrebni parametri za novi sloj. Za vrstu sloja 
odabrati tačke (Point), za koordinatni sistem odabrati MGI 1901 / Balkans zone 7 
(EPSG:3909). Prilikom digitalizacije će se upisivati i visine digitalizovanih tačaka. Zato 
treba dodati novi atribut u atributnu tabelu sa nazivom H. Za ovaj atribut definisati  tip 
podataka: Decimal Number, Precision 2 (dve decimale) i potvrditi sa Add to atributes list. 
Nakon potvrđivanja ovih parametara otvara se dijalog za snimanje novog sloja. Novi sloj 
treba snimiti pod imenom Kote_brojindeksa.shp. 

 Napomena: pored datoteke sa nastavkom shp, za ovaj sloj se formira još nekoliko 
datoteka sa istim imenom ali sa različitim nastavcima. Za prenos ovog sloja na drugo 
mesto, moraju se prekopirati svi fajlovi sa istim imenom. 
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Slika 33 Definisanje parametara za novi sloj sa tačkama 

Nakon ovog postupka, u spisku slojeva će se pojaviti novi sloj sa tačkama. Za ovaj sloj 
podesiti simbol za tačku tako da bude kontrastne boje i oblika u odnosu na pozadinu – 
topografsku kartu. 

Nakon ovoga se može početi sa digitalizacijom visinskih tačaka – kota sa topografske 
karte. Editovanje sloja Kote_brojindeksa  počinje time što se ovaj sloj napravi aktivnim 

označavanjem u spisku slojeva. Editovanje se omogući pritiskom na dugme . Za 

dodavanje novih tačaka odabere se dugme  . Aktiviranjem ove funkcije na sloj koji 

se edituje se dodaju novi objekti. Kursor na grafičkom prikazu će se promeniti u . 
Potrebno je približiti (zumirati) detalj na karti i što tačnije namestiti krstić na kotu i 
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pritisnuti levi taster miša. Označavanjem tačke se otvara dijalog za unos podataka u 
atributnu tabelu 

 

Slika 34 Digitalizacija tačke sa skenirane karte 

Digitalizovana tačka će se prikazati preko skenirane karte svojim simbolom. Na ovaj 
način digitalizovati i ostale visinske tačke – kote sa topografske karte. Povremeno je 

potrebno snimiti urađeno, pritiskom na dugme: . Editovanje sloja se završava 

ponovnim pritiskom na dugme  kojim je i započeto editovanje. 

 Snimiti ekran gde se vide digitalizovane tačke. 
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15. Digitalizacija polilinija sa georeferencirane karte 

U istom projektu u kome su digitalizovane tačke sa visinama pristupiti digitalizaciji 
linijskih entiteta. Sa karte će se digitalizovati pravci saobraćajnica. Pritiskom na dugme 

 se otvara dijalog za formiranje novog sloja. Za ovaj sloj se odabere tip Line. Za 
koordinatni sistem odabrati MGI 1901 / Balkans zone 7. U atributnu tabelu dodati tri 
nova atributa tekstualnog tipa dužine 20 znakova sa nazivima: vrsta, od, do. U polje 
"vrsta" će se prilikom digitalizacije upisivati vrsta saobraćajnica (pruga, asfaltni put ...) u 
polje "od" mesto početka i u polje "do" mesto kraja saobraćajnice. 

 

Slika 35 Podešavanje parametara za kreiranje novog sloja sa linijama 

Potvrdom na OK se otvara dijalog za izbor lokacije i naziva datoteka novog sloja gde će 
se uzeti naziv Saobracajnice_brojindeksa i potvrditi sa OK. 
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U spisku slojeva će se pojaviti ovaj novi sloj. Odabrati boju linije koja će biti vidljiva na 
skeniranoj karti. Nakon toga se može pristupiti digitalizaciji – precrtavanju saobraćajnica 
sa karte.  

U spisku slojeva označiti sloj sa saobraćajnicama i pritiskom na dugme  se 

omogućuju promene na sloju. Pritiskom na dugme  počinje dodavanje novih linija. 
Pokretanjem ove funkcije će se promeniti oblik kursora. Potrebno je zumirati prikaz kako 
bi se precizno mogla precrtati linija odabrane saobraćajnice sa karte. Tačke na liniji se 
biraju pritiskom na levi taster miša. Linija se završava pritiskom na desni taster miša. 
Nakon toga se otvara prozor gde treba upisati potrebne podatke u atributnu tabelu. 

 

Slika 36 Unos podataka u atributnu tabelu za sloj saobraćajnice 
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Digitalizovana linija će se prikazati preko skenirane karte. Povremeno je potrebno snimiti 

urađeno, pritiskom na dugme: . Editovanje sloja se završava pritiskom na dugme 

 kojim je i započeto editovanje. 

 Snimiti ekran sa gde se vide digitalizovane saobraćajnice. 
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16. Digitalizovanje poligona sa skenirane karte 

Na prethodno opisani način formirati novi sloj sa nazivom Koriscenje_brojindeksa. Za 
ovaj sloj treba odabrati tip Polygon. Odabrati koordinatni sistem MGI 1901 / Balkans 
zone 7. U atributnoj tabeli dodati dva tekstualna polja dužine 20 sa nazivom "koriscenje" 
i "naziv". 

Digitalizacija poligona se odvija na sličan način kao i digitalizacija linija ili tačaka. 

Omogući se editovanje na sloju Koriscenje_brojindeksa pritiskom na . Dodavanje 

novog poligona počinje se pritiskom na . Kod poligona se biraju granične tačke 
linije. Završetak digitalizacije poligona se postiže pritiskom na desno dugme miša, nakon 
čega se otvara prozor za unos vrednosti atributa.  

Na sloju Koriscenje_brojindeksa će se digitalizovati površine sa različitim načinom 
korišćenja zemljišta. Treba digitalizovati vodene površine, urbana područja i područja 
pod šumom. Za vodene površine i urbana područja u atributnu tabelu upisati i nazive. 

 Snimiti ekran sa digitalizovanim površinama različitog načina korišćenja zemljišta. 
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